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IPM 2007 to IPM 10:  
Making the Transition 
 

At first glance, you may think IPM 
10 is an updated version of IPM 

2007. It looks more modern, but 

has the same familiar layout and 
look and feel. The toolbar looks 

the same, if a little nicer; you may 
think “Ok, I can deal with this.”  

Then you look a little closer. The 
menus are different.  There aren’t 

any function keys along the 

bottom.  The “Current Settings” 
box is gone. Uh-oh! To borrow a 

slogan from a defunct auto 
maker, this isn’t you father’s IPM any more.  
 

IPM 10 is definitely the offspring of IPM 2007, but more like it’s grandchild than its child. It’s 
been entirely rewritten from the ground up, and doesn’t actually share a line of code with 

IPM 2007 – but it does inherit the same concepts, business rules and processes.  Of course, 
recasting IPM in the best current technology meant streamlining, reorganizing and simplifying 

a lot of things.   
 

For example, IPM 10 has about half the screens of IPM 2007. That means less clicks to do 

anything, and less time.  For example, in IPM 2007, to write a check, you: 
• Click the Checks icon, then  

• Select the cash account, then  

• Select Consolidated or Property cash balance, then  

• You get the screen to create the new check. 

 

In IPM 10, you: 
• Click the Checks icon, then 

• You get the screen to create the new check. 

 

The cash account and consolidated/property cash selections are still available, but default to 

make check writing faster and more efficient.  It’s also a natural, intuitive change that 
doesn’t really require a lot of explanation. That’s one of the best examples of the kind of 

changes throughout IPM 10.  This guide is designed to point out this type of change, and the 
enhancements that may not be so obvious.  We’ll go through the application’s main screens 

to give you the head’s up on IPM 10, and once you understand the changes, where ever you 
see them, you’ll know what you’re looking at. 

 

IPM 10 does look new and different, but we’re very confident that you’ll find most of the new 
features intuitive and natural, especially if you’ve used other Windows applications.  You’ll 

see things we’ve learned from Word, Quickbooks, and TenantPro and a dozen other 
applications to make IPM 10 the best property management software solution possible. And 

that’s only the beginning!
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Basics 
Selection Tree Replaces Pop-up List 

IPM 2007 has a variety of ways of selecting 

tenants, accounts and other things, mostly in 
pop-up lists. For example, the Tenant screen in 

IPM 2007 has a ‘Find’ button that pops up a 
screen where you can select a tenant by name 

or unit.  That’s gone in IPM 10. 

  
All the appropriate screens in IPM 10 where you have things to select follow a simple format: 

selection tree or list on the left, detail on the right.  For example, IPM 10’s Tenant screen has 
a list of tenants by property and unit on the left, and the selected tenant’s info on the right.  

The ‘find’ function is on the toolbar where it makes sense. If you type in part of a name of a 
unit number, it’ll highlight that item in the list, and you can hit enter to make it current.   

 

Account Dropdown Replaces Manual Entry 
Throughout IPM 2007, when you need to assign 

an account number, you have to type it in, or 
use ‘F5’ to display the list and select it from that.  In IPM 10, everywhere you need to select 

an account number, there’s a dropdown with the correct range of numbers (i.e., income for 

receipts, expense for checks). 
 

True “MDI”  - Multiple Windows at Once 
The term MDI stand for Multiple Document 

Interface.  IPM 2007 looks like an MDI 
application, as all the screens reside inside a 

main, background screen – but you can only 

access one screen at a time! IPM 10 changes 
that.  IPM 10 allows you to view multiple 

screens at once: that means multiple copies of 
one screen or multiple different screens.  Some 

screens need to be exclusive, so you can’t show 

multiple copies of these windows, like the 
Preferences or the Printer Setup.  

 
The big thing to remember about having multiple screens open is that each screen has its 

own set of data, so if you’ve got the unit screen up and the property screen up and you add 

a property, don’t expect to see that new property on the Unit screen until it’s reloaded.  If 
this makes sense to you, you won’t have ANY problems using IPM 10. 

 
Separate Check and Report Printers 

We heard our users complain about using a 
printer down the hall for checks, and the one at 

their desk for reports – and forgetting to change 

them in IPM 2007!  We also looked at 
Quickbooks with its myriad, complicated printer 

setup and knew that wasn’t for us, either.  IPM 
10 supports up to two printers: one for printing 

checks and one for printing reports. And you can 

change them from the ‘print checks’ and ‘print 
reports’ screens!  
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Interface Changes 
‘Set’ Menu to Checkbook Screen 
IPM 2007’s checkbook options (including Chart of Accounts, CAM Accounts, User Fields and 

accounts used for reporting) were under the ‘Set’ menu, along with database and application 
options. In IPM 10, all the options that apply to a checkbook are set up on the Checkbook 

Screen. Under the Tools menu, you have preferences for the database and the application. 
 

‘Updates’ to ‘Tools’ 
Functions from the Updates menu have been moved to the Tools Menu’s ‘Updates’ option, or 
the toolbar. Keyboard shortcuts are also available. The new Tools menu is described below. 

 
‘Receipts’ changed to ‘Receivables’ 
IPM 10’s Receivables menu includes the features and functions found in IPM 2007’s ‘Receipts’ 
menu and IPM 2007’s ‘Charges’ menu, grouping everything about income in one place. 

 
‘Payable’ changed to ‘Payables’ 
IPM 10’s Payables menu mirrors IPM 2007’s Payable menu. 

 
‘Charges’ changed to ‘Receivables’ 
The items from IPM 2007’s ‘Charge’ menu are now found in IPM 10’s ‘Receivables’ menu.  

 
‘Journal’ changed to ‘Accounting’ 
IPM 10’s Accounting menu includes the functions of IPM 2007’s Journal Menu, plus the (now 
nearly insignificant) End of Year Close, Check Journal Maintenance and Bank Reconciliation. 

 
New ‘Preferences’ Screen 
While the checkbook option have migrated from the ‘Set’ menu to the checkbook screen, that 

left general database options and application options that had to go somewhere. They’re in 
IPM 10’s ‘Preferences’ screen under the ‘Tools’ menu, following the standard of most 

Windows applications. Here you’ll find choices for how IPM starts, does backups and where it 
looks for files.  There’s also options specific to the current database – the default state and 

zip code, and setup for the Tracking subsystem. 

 
New ‘Windows’ Menu 
Here you can change appearance options, like whether or not the menus have titles under 
the icons, and whether or not you have Ticklers displayed. 

 

IPM 10 allows you to have any number of screens displayed at the same time, so you can 
view a tenant, preview a report and check a vendor at the same time. You can also 

“maximize” the client windows (the ones that show in the IPM workspace), to follow the 
Windows standard for the ‘multiple document interface’. When you maximize your client 

windows, the Windows Menu allows you to switch between the displayed windows. Try it, 
and you’ll see it’s a lot easier than it sounds. 

 

New ‘Tools’ Menu 
IPM 10’s new ‘Tools’ menu makes IPM more consistent with other Windows application. This  

menu includes the ‘Updates’ functions above, along with maintenance options such as ‘Mass 
Maintenance’; ‘View Screens’ for name lookups, balances at a glance, and consolidated cash; 

‘Archive’ and ‘Retrieve’ records; ‘Repair and Compact’ database, ‘Ticklers’, ‘Mail Merge’ and 

‘Preferences’.    ‘Preferences’ replaces the “Set System Defaults’ in IPM 2007.  
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IPM 2007’s ‘Set Account Defaults’, ‘Set MICR Information’ and ‘Set User Fields’ have been 
relocated. IPM 10’s Checkbook screen has defaults for Check Printing, including MICR, User 

Field set up, CAM field set up, and Management/Balance Sheet/Operating Accounts.  There’s 

also a tab for the Chart of Accounts setup,  with the Account Defaults from IPM 2007.  IPM 
allows has no limits to cash accounts, management accounts, user fields, CAM charges, 

unlike IPM 2007. 
 

Changes in How to Do Things 
Posting 

In IPM 2007, you’re prompted with “Do 

you want to Post this now?” every time 
you create anything that can be posted. 

That’s been replaced in IPM 10 with a 
checkbox on any form that creates a 

postable entry, labeled “Automatically 

post.” There is also an option on the 
‘General and  Setup’ tab of the 

Preferences screen to make this default to 
checked. So, if you’re a small office and 

don’t want to review your entries before you post, that’s one less step for checks, receipts, or 

journal entries. 
 

Create Charges/End of Month Close 
In IPM 2007 your monthly cycle was 

always marked by creating charges 
for the next month on or about the 

last day of month, under the ‘Closes’ 

menu’s ‘Create Charges (EOM)’ 
option. In IPM 2007, the EOM reset 

counters to zero, and charged the 
tenants or members for the next 

month.  There’s no need for an “end 

of month close” in IPM 10, because 
all its totals are date driven.  

 
There are two options for charging 

residents. First, under the 
‘Receivables’ menu, you’ll find  ‘Create Recurring Charges (Rent).’ For HOAs and Condos, it 

will read ‘(Assessments)’. The Create Recurring Charges screen shows you who will be 

charged, and how much. You can change the billing or exclude residents, and you’ll get 
detailed feedback throughout the process.   

 
The second option is to automatically charge 

when due.  This option can be activated on 

the ‘Properties’ screen by checking the ‘Auto 
Bill’ checkbox on the main screen for each 

property. With this option selected, when 
the posting date goes to or past the next due date for your residents, IPM will ask you if you 

want to create charges.  If you don’t want to, select ‘no’, and you’ll be asked again until you 

select ‘yes’.  Since creating charges in IPM 10 updates the ‘next date due’ by the billing 
period (monthly, weekly, etc), there’s no chance of duplicating charges. 
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End of Year Close 
In IPM 2007, the End of Year close could be 

stressful at the worst possible time of year.    
More over, you were really doing two things 

at once: finishing the old year, and starting 
the new year, so you needed to do it just to 

write checks for January. 
 

This process has been streamlined for IPM 

10.  In IPM 10, to begin entering new 
transactions for the new year, just change the posting date!  IPM 10 does not require you to 

close the previous year before starting the new one. 
 

When you are ready to close the previous year, go to the ‘Accounting’ menu and select ‘Close 

Previous Fiscal Year.’  This function stops you from being able to post to the previous fiscal 
year, and calculates your Retained Earnings for the current year.  It also moves figures from 

your Projected Year budget to your Current Year budget, and Current Year budget figures to 
the Previous Fiscal year.  It’s really that simple! 

 

If you’re on an older computer, or have limited hard drive space, you can archive the 
transactions from the previous year, too – but you don’t have to. 

 
Change Posting Date 
IPM 2007 asks for a posting date every time you change the selected checkbook. Of course 
you can also change the date by clicking on the date in the upper right corner of the main 

screen, and you can go backwards and forwards to any date – but many IPM users don’t 

even know that. 
 

IPM 10 doesn’t ask for a new posting date, period.  Any time you want to change the posting 
date, click on it in the upper right corner.  And changing the posting date in IPM can 

automatically bill your residents or change your fiscal year. 

 
IPM 10 also offers an option on the Preferences/Global Defaults/General and Startup screen 
to ‘Automatically Update Posting Date’ every time you open IPM or change a database or 
checkbook.  That means the IPM will automatically change the posting date to the actual 

date every day, a boon for people used to Quickbooks; if you don’t like that, don’t check that 
option.  

 

Mail Merge 
IPM 2007’s Tenant/Member, Vendor and Owner forms have given way to a true mail-merge 

with industry-leading Microsoft Word.  Now your merged documents can include not only the 
data from IPM but tables, images and all the other features of Word. Much like IPM 2007, 

mail merge works in two steps: 1) create the master document, and 2) run the merge.  

Master documents need to be created originally in IPM, but thereafter can be edited in Word. 
 

 

Changes to Lesser-known Functions 
Lock Box and Direct Deposit 

IPM 2007 supported its own proprietary coupon printing and lockbox import. It was 
underutilized, as most associations prefer bank-printed and distributed coupons.  IPM 10 
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resolves that issue.  It supports most standard bank lockbox formats. The Tenant/Member 
Directory is all you need to include with your coupon order.  For banks that include ACH and 

other forms of Direct Deposit in their lockbox format, IPM 10 will work with them, too. 

 
Ticklers 

Probably the most powerful and useful feature of IPM 2007 that no one used was the 
Ticklers.  Drawn from the banking industry, the tickler is a reminder or an item on an 

electronic to-do list.   In IPM 2007, ticklers are saved with the database, so if you’re working 
in database A, you could miss an event in database B.   

 

IPM 10 has a separate tickler file that can be shared by everyone in a department or 
company.  It also has features taken from the best of breed in CRM and scheduling, including 

recurring events and assignment to particular users. This means that Marty can assign a task 
to Josh – and both can see their own tasks, all tasks or anyone’s in particular. Naturally you 

can print a list of tasks to check off during the day. 

 

Getting ready to move to IPM 10 
The first step in using your data in IPM 10 is the import. Since IPM 10 has literally hundreds 
of additional fields not found in IPM 2007, you can’t just open your IPM 2007 database in 

IPM 10. You have to copy the data from your database into a new IPM 10 database, and 

there’s and Import wizard in IPM 10 to do that for you. 
  

Since IPM 10 manages charges differently from IPM 2007, be sure to set your posting date in 
an “un-closed” month.  For example, if you’ve billed for June 1, put your posting date in June 

before doing the import.  The reason is that IPM 10 tracks the Next Charge Date, something 

IPM 2007 didn’t do. Therefore, since that data isn’t saved in IPM 2007, we need to generate 
it during the import, and the way to do that is using your posting date.   

 
This is even more important if you’re charging either weekly or biweekly. IPM 10 will 

calculate from the posting date, so make your last charging date.  Of course, you can change 
the next charging date on the tenant screen’s lease panel in IPM 10, too. 

 

The other ‘Big Difference’ between IPM 2007 and IPM 10 is how tenant records are handled. 
In IPM 2007, the Charge/Due screen allowed you ‘quick and dirty’ access to charges and 

most amounts due. The problem was that this easy access meant that at times the 
Charge/Due screen and the Tenant Ledger got out of synch.  In IPM 10, all tenant 

information flows from the tenant ledger. The Financials tab replaces the Charge/Due screen 

and offers a simple categorical summary of amounts owed and charges, but it is not an 
editable screen. It is a categorical ‘report’ of sorts of the tenant ledger.  So, before you 

import your data into IPM 10 clean up your tenant ledgers! 
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How to Move to IPM 10 
That’s simpler than you might expect – just 

import your data.  You can either use 

File/Open IPM Database or File/Import.  If 
you use File/Open, when IPM 10 detects 

that the database is in IPM 2007 format, it’ll 
start the Import wizard. Click ‘next’ until the 

wizard is done.  If you select Import option 

from the File menu, you’ll start the same 
Import wizard. Select “an IPM 2007 

database” and click next through the 
Wizard. In either case, you’ll need to 

examine the database in detail to make sure 

that the import worked as you expected.   
 

IPM 2007 databases often have a multitude of small errors that can make a big impact on 
the import, such as spaces in some of the index fields, dead or partial transactions, et c.  

FullHouse Software is happy to offer guidance in helping you clean up your IPM 2007 
database to make the import as clean as possible. There may still be some manual cleanup 

to accommodate all the additional fields and options in IPM 10. 

 
We recommend that you run IPM 2007 and IPM 10 in parallel for a month. This isn’t 

essential, but it allows you to gain confidence in how to use IPM 10.   
 

Conclusion 
As you may have guessed by now, there’s a lot more to IPM 10 than just a pretty face. It’s a 
fifteen-year jump in technology.  In that time, cell phones have gone from brick-sized 

oddities to ubiquitous tools.  If you’ve finally decided to switch from your 1994 cell phone to 
a modern iPhone or Palm, it’s not going to be without some challenges – and you certainly 

aren’t going to be able to transfer your call phone book (if your old phone had one!).   

 
The transition from IPM 2007 to IPM 10 will hopefully be more intuitive. If you use lots of 

Windows programs, we know the transition will be easy; if IPM is about the only program 
you use, it may involve a steeper learning curve.  But once you get over the changes, you’ll 

benefit from new features, faster processes and too many enhancements to count.  


